Welcome to Kingdom of Drakkar

Kingdom of Drakkar is a game of adventure and camaraderie. You explore the lands of the kingdom, building your
skills as a Fighter, Paladin, Barbarian, Martial Artist, Mentalist, Healer, or Thief. You can adventure alone or with
other players as you battle deadly creatures, engage in quests, and find treasure to help you survive in the many
lands of the kingdom.



Laws of the land

. Killing player characters is strictly forbidden.

- Killing hostile creatures and non-player characters is crucial to your survival. This is primarily how you
build your experience level and your skill level.

- Killing non-hostile creatures is left to your discretion, but be warned that slaughtering innocents will affect

your alignment.



Getting Help
You can get Help about Kingdom of Drakkar in the following ways:

. Display Tooltips for the areas of the user interface by pausing the mouse pointer over the area.

. Click What Is? on the Help menu, and then click the area of the game interface you want help with.
- Display or print the map of Nork.

- Open or print the online document (DRAKKAR.DOC) in your MPG-Net\Games\Drakkar folder.

. Ask other players

- Access the Drakkar Help Manual from the MPG-Net web page at mpgn.com

{button ,AL("TooltipInfo")} Related Topics



Kingdom of Drakkar

You are a bold one to enter the Kingdom of Drakkar, where dangerous creatures defend their treasures with exotic
weapons and the power of their minds. Try to find fellow characters to aid you in your quest and, as your character
gains power, new challenges will arise: Portals connect forbidden cities, and lands exist that no one has yet
discovered.

The Town of Nork, Volcano Town, the Province of Maeling, and the City-State of Frore are the only known cities
that remain within the Kingdom of Drakkar. Fractured into different islands after the Empress released Evil into the
Kingdom centuries ago, the only remnants of their shared history are the portals that connect them. The men and
women who live on these islands lead isolated lives and protect their homes with whatever means they can. Ice
fields, deserts, volcanoes, and treacherous oceans keep them from venturing too far. Those who wander soon
discover lands and beasts that have only been dreamed of.




Town of Nork

Nork is the most hospitable town. The weather is warm and sunny, the citizens are usually friendly, and strangers
can find food, lodging, and shops that will sell them most anything they need for their quests. A lucky person could
find fortune and fame without ever venturing past the town limits. However, Nork is not without its dangers.
Centuries ago, the people of Nork formed an Elite Guard to protect them from the Evil the Empress had loosed. The
Guard built barracks deep under the town and kept a constant watch, ready to defend the town and pursue attackers
at a moment’s notice. A strong and fierce crew, the Guard consisted of the most highly skilled warriors ever
assembled.

No one knows why the Guard turned against Nork, but soon after the establishment of the Officers’ Barracks, the
Guard began a ruthless attack from deep within the labyrinth below Nork, slashing their way toward the surface,
leaving only destruction in their wake. Just within the reach of victory, the Guard mysteriously retreated to the dark
shadows of their labyrinthine stronghold, there to remain a menacing, silent threat.

Fearing another assault, the loyal Norken forces called upon the great Mentalists of the land, skilled in psionic
power, to create an unbreakable seal around the barracks and prevent the rebel forces from returning to the surface.
Through the years, sojourners who travel to the dungeons beneath Nork have told stories of strange noises rising up
from the sealed barracks, and some have witnessed ghostly apparitions. Many have never returned.

{button ,AL("NorkInfo")} Related Topics



Map of Nork
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Province of Maeling

Seven Martial Artists left Nork and traveled for years before coming to a valley. There, they built Maeling in honor
of the Dojo who trained them. Inside the fortified walls of the city, the streets are ominous and full of small shops
and secret gardens. A walled pathway, etched with griffons and brightly colored dragons, follows the edge of the
buildings, adding protection against the untamed creatures that roam outside.

For the traveler, Maeling is a difficult city to understand. The inhabitants use an uncommon dialect, indigenous to
Maeling, and the shops sell exotic wares. Outside the city, a forest leans back against the mountains, which are
honeycombed with caves. Strange beasts inhabit the Maeling wilderness, where only the very brave and skillful
survive.



Volcano Town

Far to the north, Volcano Town rises from the sea. It is exceedingly hot and dry, and travelers, disoriented from the
heat, often fall from the cliffs and tumble into the sea. A large well in the center of town emits sulfurous fumes, and
the constant threat of volcanic eruption has deterred many merchants from opening shops.



City-State of Frore

Below the Equator, the grassy veldts turn into fields of ice, where is found the land of Frore, a forbidding place.
Armed with strength and cunning, four mighty warriors took it upon themselves long ago to rid the southernmost
lands of all threats and established the City-State of Frore. They destroyed all beasts who threatened their new city,
save one: the giant Snow Beast.

The fearsome cry of this monster sliced through the air on many a frigid evening. The sound terrified the
townspeople into fortifying their city-state with double walls and Golden Dragons. Fear of the Snow Beast had made
the citizens prisoners within their own homes.

These citizens pleaded with the four warriors who had brought them into this possessed land. The Four, as they had
come to be known, agreed to "divide and conquer" -- each one seeking a way to destroy the vile Snow Beast. One
sought the seclusion of the Northern Caves. Another built a fortress west of the city. A third excavated a complex to
the south. The last built a castle directly above the city proper.

The Four became fanatical in their quests, slipping deeper and deeper into madness and despair. One strayed too
close to the forces of Evil and became a mere shadow of his former humanity. Another made a fearsome pact with
the Queen of Wyrms. The third designed a weapon of such evil that it drove him from the forces of Light. The last
went insane.

Now the lands of Frore exist as a shattered kingdom whose citizens live in fear of the Snow Beast and of the Four
who were meant to save them.



Your characters

You can create four characters on your MPG-Net account, although you can only play one character at a time.
Having multiple characters lets you play characters with different skills and abilities. For example, one of your

characters might be a male City Dweller dedicated as a Fighter, and one of your characters might be a female
Outcast dedicated as a Martial Artist.




Rerolling a character

If you reroll an existing character, you wipe out the character's abilities, experience, skills, disciplines, and any items
the character is wearing or carrying. However, any items in the character's locker and any coins in the character's
bank account will be retained for the new character. You should put any items you want to pass on to the new
character in your locker before you reroll the existing character.

The new character also inherits some of the previous character’s experience and skill by being able to achieve half
the previous character’s experience and skill level more quickly than usual.



Sharing attuned items

Some items in the kingdom attune to you when you pick them up or have them specially made. For example, if you
take a creature’s skin to the Tanner to be made into armor, only you and other characters on your MPG-Net account
can wear the armor the Tanner makes.




To choose your character’s sex
] Click the Female icon or the Male icon.



Choosing your character's race
Each race has different strengths and weaknesses.

. City Dwellers

. Forest Dwellers

. Mountain Dwellers

- Outcasts

. Underground Dwellers
. Woodlands Dwellers

To choose your character’s race
b Click the large picture. The small picture shows how a character of each race looks in the kingdom.



City Dwellers
City Dwellers are strong and extremely lucky.



Forest Dwellers
Forest Dwellers are agile and extremely charismatic.



Mountain Dwellers
Mountain Dwellers are strong and have strong constitutions.



Outcasts
Outcasts are rumored to have great strength but little luck.



Underground Dwellers
Underground Dwellers are agile and have strong constitutions.



Woodlands Dwellers
Woodlands Dwellers are intelligent and have strong willpower.



To name your character
» Type a name of 3 to 14 letters.



Rolling your character's abilities

Your character’s abilities range from a low of 3 to a high of 18. Most abilities remain the same throughout a
character's life, although some increase or decrease.

. Strength

. Intelligence
. Wisdom

. Willpower

. Constitution
- Agility

. Charisma

. Health

. Gold

' Luck

To roll your character’s abilities
] Click Reroll until you are satisfied with your character's abilities, and then click Accept.



Strength

Strength is essential for physical combat. It determines how much damage you inflict when you attack with a
weapon, and how much weight you can carry without becoming encumbered.



Intelligence

Intelligence is essential for forming psionic disciplines. Intelligence determines how much psionic energy a
character initially possesses and how much energy he or she gains at each experience level.



Wisdom

Wisdom is essential for forming healing disciplines.



Willpower
Willpower determines your tenacity and ability to resist the effects of psionic disciplines.



Constitution
Constitution determines the number of health points you initially possess and the number of health points you gain
at each experience level. A strong constitution prevents you from being stunned in combat, and it also determines the
number of times you can be raised from the dead.



Agility
Agility determines how accurately you hit and how quickly you dodge blows in combat.



Charisma

Charisma determines how well you get along with others. If you are particularly charismatic, you might get better
prices from the shopkeepers or have a better chance of forming disciplines that influence creatures.



Health

Health determines how much physical damage you can sustain before dying. Your constitution determines your
initial health and the number of health points you gain at each experience level.



Gold
Gold indicates how many gold coins are in your sack when you arrive in the kingdom.



Luck

Luck influences the outcome of random events. The higher your luck, the better your chances of successfully
forming psionic disciplines and setting and disarming traps, among other things.



Identity box

An Identity box appears for each creature and character near you. The Identity box shows the character or creature's
name, flag, contents of right and left hands, armor, and health heart.
. Name

Hostile creatures and characters have red name boxes. Trainers, shopkeepers, and questors have blue name
boxes. Non-hostile creatures and characters have gray name boxes.

- Flag
The flag in the upper-left corner of the Identity box corresponds to a character or creature in the Terrain window.
If an Identity box does not have a flag, the character or creature is standing on you. If it's a hostile creature, you'd
better be swinging at it!

- Health heart

The heart in the upper-right corner of the Identity box indicates a character or creature's health. If the character
or creature is in full health, the heart is completely red. If the character or creature is wounded, the heart is only
partially red according to how severely the character or creature is wounded. If the character or creature is
poisoned, the heart is green. If the character or creature is stunned, the heart has a halo of stars.

- Right and left hands

The right and left squares of the Identity box display the items a creature or character is holding.
. Armor

The center square of the Identity box shows the armor a creature or character is wearing. A bull's-eye appears
over the armor of the creature or character you last attacked.



Terrain window
The Terrain window shows where you are standing in the kingdom.



Narrative window

The Narrative window shows information such as the play-by-play during combat, your conversations with other
characters, and the contents of any scrolls you read.



Ground window

Ground
42

The Ground window shows the ground where you are standing.

The left column of the Ground window shows how many items of a particular type are on the ground. For example,
if a pile includes three gems, the column on the left shows one gem (whichever is on top of the pile) and the number
3 to indicate that there are three gems in the pile. To see what kind of gems are in the pile, click the gem in the left
column; the different gems then appear in the right column.



Experience points

You gain experience points by killing opponents. As your experience points increase, your experience level
increases. When you accumulate enough experience points to advance to the next experience level, a message
appears in the Narrative window telling you to Rest when you are fully healed.




Experience display

e 200
The Experience Display indicates your experience points and experience level.

To toggle the Experience display
b Click the Experience Display button.



Health points

You gain health points at each experience level. You lose health points when you are wounded in combat, but they
regenerate with time. The better your constitution, the faster your health points regenerate. You can speed the
regeneration of health points by resting, drinking a healing potion, or having a Healer form the Mend discipline or
the Heal discipline on you.




Health display

o= az
The Health Display indicates your maximum and current health points. You can display your health points as
numbers or as a bar gauge.

To toggle the Health display
] Click the Health Display button.




Psionic energy points

Psionic energy is the power of your mind. Mentalists, Healers, and Thieves use psionic energy to form psionic
disciplines. If you are a psionicist, each discipline you form costs a certain amount of energy. For example, forming
the EnMiss (energy missile) discipline costs five psionic energy points, so each time you form EnMiss, your psionic
energy decreases by five points. If you try to form a discipline that costs more psionic energy points than you have,
you will not be able to concentrate enough to form the discipline, and you must wait until your psionic energy
regenerates. Psionic energy points regenerate with time, and the speed at which they regenerate is determined by
your skill level. Unlike health points, you cannot accelerate regeneration by Resting; however, you might find
potions that restore psionic energy.




Psionic Energy display

T ag
The Psionic Energy Display indicates your maximum and current psionic energy points. You can display your
psionic energy points as numbers or as a bar gauge.

To toggle the Psionic Energy display
] Click the Energy Display button.




Sack

There is space in your sack for 30 items and one million gold coins -- once you find them. Your sack (and your
pouch) hold most small- and medium-sized items, such as gems, scrolls, succor twigs, bottles, and anything you can
wear except armor, cloaks, and robes. Daggers are the only weapon small enough to put in your sack or pouch.
Other weapons hang from your belt. Your sack is the only place you can stash coins (other than the bank.)

To open your sack
] Click the Sack button.



Pouch

There is space in your pouch for five items. Your pouch (and your sack) hold most small- and medium-sized items,
such as gems, scrolls, succor twigs, bottles, and anything you can wear except armor, cloaks, and robes. Daggers are
the only weapons small enough to put in your pouch or sack. Other weapons hang from your belt.

To open your pouch
b Click the Pouch button.



Belt

There is space on your belt for five items. Your belt holds shields and most weapons, except halberds and polearms.
Scrolls and succor twigs are the only non-weapon items that can hang on your belt. Most other items fit in your sack
or pouch.

To display your belt
] Click the Belt button.



Locker

There is space in your locker for 20 items of any size, except twigs, coins and corpses. Your locker is a good place to
stash spare or valuable items that you do not want to risk losing if you die in combat and are stripped of your
possessions. Only you can open your locker. If you reroll a character, the new character inherits the contents of the
locker. In Nork, your locker is in the Steel Flower Tavern.

To open your locker
1 Go to the Steel Flower Tavern.

2 Stand in front of the locker, and then stand on the locker to trip the pressure plate in the floor that opens your
locker.

3 On the Show menu, click Locker. The contents of your locker appear.



Encumbrance display

The Encumbrance display indicates how much weight you are carrying. If you are encumbered, even lightly, you
move slower.

i
’? Lightly encumbered.

i
“I” Moderately encumbered.

il Heavily encumbered.



Returning from the dead

When your health points drop to zero, you are dead. When you die, you hover above your bloody corpse. You can
ell for help but can do nothing else.
To return from the dead

] Type restore

If your character's constitution is strong enough to stand the shock of resurrection, you appear in the recall area for
the land you are adventuring in. You lose one constitution point each time you die, and some creatures may strip you
of your possessions after they slay you.

To choose a Healer trainer to return to
1 Stand on the Healer trainer.
2 Type the Healer's name, followed by a comma, and then type recall me
For example, to have a Healer named Ewok recall you, type Ewok, recall me



Alignment

Your alignment indicates whether you have good, neutral, or evil tendencies. All characters enter the kingdom with
an alignment that is good with good tendencies. However, your alignment reflects your actions in the kingdom, so if
you kill innocent creatures, your alignment will eventually change from good to neutral to evil in the following
increments:

good with good tendencies

good with neutral tendencies

neutral with neutral tendencies

neutral with evil tendencies

evil with evil tendencies

b . S .

To display your alignment
] Type list stats
Your alignment appears in the Narrative window.




Dedicating to a profession
New characters arrive in the kingdom as members of the merchant brotherhood. Merchants are welcome to explore

Thief.
When you decide which profession to pursue, you must find the appropriate trainer and dedicate your life to the

pursuit of that profession.

To dedicate to a trainer

1 Stand on the trainer.

2 Click the trainer’s Identity box. The trainer appears.

3 If you want to know what profession the trainer is licensed by, pause your mouse pointer over the trainer, or
click What Is? on the Help menu, and then click the trainer.

4 If you want to become a member of that profession, click Dedicate.
When you dedicate to a profession, you receive credit toward your first training session.



Fighter

Fighters are masters of weapons who Attack, Shoot, or Stab their opponents.

Fighters need particular abilities to survive in the kingdom. They must have sufficient strength to damage their
opponents in combat, sufficient agility to hit accurately and parry blows, and a strong constitution to withstand
injuries from physical combat.

Fighters who attain the 8th experience level with an alignment of good with good tendencies can become Paladins.
Fighters who attain the 15th, 17th, and 20th experience levels can specialize in a weapon and thus receive greater
skill gains and inflict increased damage in combat.

{button ,AL("FighterInfo")} Related Topics



Paladin

Paladins are noble Fighters who have attained the 8th experience level with an alignment of good with good
tendencies. Fighters can become Paladins by dedicating to the Paladin trainer. Paladins can continue to receive
weapons training from the Fighter trainer, but they must go to the Paladin trainer for specialization training.

Paladins have greater combat abilities than Fighters and are more resistant to psionic attack. However, Paladins must
remain faithful to the forces of good. If they slay a non-hostile creature, even accidentally, they are stripped of their
Paladinhood and must seek atonement in order to regain it.

Paladins who attain the 15th, 17th, and 20th experience levels can specialize in a weapon and thus receive greater
skill gains and inflict increased damage in combat.

{button ,AL("PaladinInfo")} Related Topics



Barbarian

Barbarians are fierce warriors who thrive on chaos and are able to carry great amounts of weight without becoming
encumbered. Their distrust of psionics makes them resistant to psionic attack; however, it also makes it difficult for
them to use psionically-imbued items. They like to break powerful items and sometimes go berserk in combat.
Barbarians need particular abilities to survive in the kingdom. They must have sufficient strength to damage their
opponents in combat, sufficient agility to hit accurately and parry blows, and a strong constitution to withstand
injuries from physical combat.

Barbarians who attain the 15th, 17th, and 20th experience levels can specialize in a weapon and thus receive greater
skill gains and inflict increased damage in combat.

Note The Barbarian trainer is on a remote and dangerous island east of Nork. If you are a beginning player, it
would be wise to dedicate to one of the other professions until you are familiar with the kingdom.

{button ,AL("BarbarianInfo")} Related Topics



Martial Artist

Martial Artists Attack or Kick their opponents with their hands or feet rather than using weapons. As they advance in
skill level, Martial Artists can also Jumpkick, Sweep, and attack their opponents using the Chi art forms. Highly
skilled Martial Artists eventually abandon armor and rely solely on their agility to avoid physical damage.

Martial Artists need particular abilities to survive in the kingdom. They must have sufficient agility to kick, jump,
block and parry blows, and move quickly in close quarters. They must also have sufficient strength to damage their
opponents and a strong constitution to withstand injuries from physical combat.

{button ,AL("MartialArtistInfo")} Related Topics



Mentalist

Mentalists focus the power of their minds into psionic energy. They must be intelligent so that they do not exhaust
their psionic energy and have to resort to physical combat. They can slay their foes quickly and from a distance,
without dirtying their hands in physical combat. However, Mentalists must concentrate and make each psionic attack
count to avoid wastefully depleting their psionic energy.

Mentalists need particular abilities to survive in the kingdom. They must have sufficient intelligence to form psionic
disciplines. Intelligence also determines how much psionic energy Mentalists initially possess and how many
psionic energy points they gain at each experience level.

True Mentalists who attain the psionics skill level of Wizard begin to regain their psionic energy at an accelerated
rate.




Healer

Healers are skilled in the use of both weapons and psionics. Although they rely primarily on psionics, Healers
should also be adept with weapons. A Healer uses more psionic energy to form an offensive psionic discipline than a
Mentalist uses, so when Healers are in heavy combat, they might deplete their psionic energy and have to fall back
on physical combat. Also, Healers, unlike Mentalists, only regain psionic energy points over time if they are
undamaged, so they must stay fully healed.

Healers need particular abilities to survive in the kingdom. They must have sufficient wisdom to form psionic
disciplines and sufficient strength to wield weapons. Wisdom also determines how much psionic energy Healers
initially possess and how many psionic energy points they gain at each experience level.

Healers use some of the same disciplines as Mentalists and have some disciplines of their own. Healers have the
special ability to use the Heal discipline to heal damage to themselves and others. A good Healer is always aware of
the health of others and is willing to lay a healing hand upon the wounded. Healers who attain the healing skill level
of Healer can restore life to a corpse using the CritCure discipline.



Thief

Thieves prefer hiding in the shadows and backstabbing their foes in surprise attacks rather than engaging in
prolonged physical combat. They also enjoy picking locks and pilfering the possessions of other characters by
stealing, mugging, and using traps. Thieves are also able to form psionic disciplines; however, they draw on their
health points each time they form a discipline.

Thieves need particular abilities to survive in the kingdom. They must have sufficient agility to set and disarm traps,
sufficient strength to backstab, and sufficient intelligence to form disciplines.

{button ,AL("ThiefInfo")} Related Topics



Walking
You can walk one step or multiple steps at a time.

To walk multiple steps

b In the Terrain window, click a location that is multiple steps from where you are standing. You move to the
location (or as far in that direction as your move rate allows).

To walk one step

1 In the Terrain window, click a location that is one step (horizontally, vertically, or diagonally) from where you
are standing. A pair of footsteps appears in the location.

2 Press ENTER to move to the location of the footsteps. Or click the Send Command Line button or click the right
mouse button.

To walk along a path

Note This is useful for walking around traps.
1 In the Terrain window, click a location that is one step (horizontally, vertically, or diagonally) from where you
are standing. A pair of footsteps appears in the location.

2 Click a second location that is one step from where you are standing. A second pair of footsteps appears in the
location.

3 Click a third location that is one step from where you are standing. A third pair of footsteps appears in the
location.

4 Press ENTER. You move to the location of the last set of footsteps. Or click the Send Command Line button or
click the right mouse button.



Opening, closing, and unlocking doors

To open a door
1 Stand in front of the door.

2 Double-click the door.

3 Press ENTER. Or click the Send Command Line button or click the right mouse button. If the door is unlocked, it
will open.

To close a door

1 Stand in front of the door.
2 Double-click the door.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.

To unlock a door

1 Hold the key (or other item) in one of your hands.

2 Stand in front of the door, and then double-click it. If you have the key or item that fits the lock, the door
opens.



Ascending and descending stairs

To ascend or descend stairs

1 Stand on the stairs.

2 Click the stairs.

3 Press ENTER. Or click the Send Command Line button or click the right mouse button.

If you were at the bottom of the stairs, you move to the top of the stairs. If you were at the top of the stairs,
you move to the bottom of the stairs.



Climbing
Some of the rocks in the kingdom are suitable for climbing.
To climb up

1 Click the Action Commands pop-up menu, and then point to Climb up.
2 Click the Initiate Action button.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.

To climb down

1 Click the Action Commands pop-up menu, and then point to Climb down.
2 Click the Initiate Action button.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.



Riding and dismounting an animal

Some of the animals in the kingdom can be ridden.

To ride an animal

Note You must have a harness in your left hand to ride an animal.

1 Click the Action Commands pop-up menu, and then point to Ride.
2 Click the Initiate Action button.
3 Click the Identity box of the animal you want to ride.

To dismount an animal

1 Click the Action Commands pop-up menu, and then point to Dismount.
2 Click the Initiate Action button.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.



Chasing a character
Chasing is a good way to follow another character over a distance without taking a wrong turn. Chasing moves

you to where a character is standing, or to where a moving character most recently stood.

To chase a character
b Type chase and then click the Identity box of the character you want to chase.

Note You must repeat the command each time the character moves.



Resting

When you are wounded, resting restores missing health points faster than they would naturally be restored over
time. When you have accumulated enough experience points and are fully healed, resting advances you to the
next experience level.

To rest

1 Click the Action Commands pop-up menu, and then point to Rest.
2 Click the Initiate Action button.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.



To look at yourself
b Type list self

Your description appears in the Narrative window.



To display your statistics
¥ Click the Show menu, and then point to Stats. The Statistics dialog box appears.



To display your skills
¥ Click the Show menu, and then point to Skills. The Skills dialog box appears.



To look at an item on the ground

1 Stand on the item.
2 Click the Ground button. The items appear in the Ground window.



To take items from the ground

One of your hands must be empty to pick up items.

1 Stand on the item.

2 Click the Ground button. The items appear in the Ground window.

3 If the item you want to pick up is in the right column of the Ground window, drag the item to its new location.

If the item you want to pick up is in the left column of the Ground window, click the item to move it to the right
column, and then drag the item to its new location.

To move multiple items, press SHIFT and drag the items from the right column to the new location.



To look at an item in your hand

1 Hold the item in one of your hands.

2 Type look at and then type the name of the item in your hand. For example, if you are holding a shortsword,
type look at shortsword
A description of the item appears in the Narrative window.

Note You must be specific about what an item is called. For example, if you are holding a sword, you must
specify whether it is a shortsword, longsword, or other kind of sword.



To look at others
b Type look at and then click the Identity box of the character you want to look at.

The character’s description appears in the Narrative window.



To look in a direction
b Type look and then type the direction you want to look. For example, to look one square north, type look
n or to look two squares north, type look n n
A description of the items you can see appears in the Narrative window. You can look up to four squares away
in the following directions: n, s, e, w, ne, nw, se, and sw.



Class training

Class training is how you receive the psionic disciplines or increased number of attacks you may have earned
since you last trained. You should always class train when you advance to a new skill level.

To receive class training

1 Stand on the trainer licensed by the profession you dedicated to.
2 Click the trainer’s Identity box. The trainer appears.
3 Click Class Train.



Skill training
Skill training helps you attain higher skill levels more quickly than you could by slaying opponents.
To receive skill training

1 Stand on the trainer.

2 Click the trainer’s Identity box. The trainer appears.

3 Click the skill you want training in.

4 Click Skill Train.

5 Type the number of coins you want to spend. The more coins you spend, the more training you receive.

The trainer takes the coins from your sack, increases your experience points according to the amount you
spent, and displays your percentage of achievement toward the next skill level.



Assessing a skill
Assessing a skill shows your percentage of advancement toward the next skill level.
To have a trainer assess your skill

1 Stand on the trainer.

2 Click the trainer’s Identity box. The trainer appears.
3 Click the skill you want the trainer to assess.

4 Click Assess Skill.

The trainer takes 50 coins from your sack and displays your percentage of achievement toward the next skill
level.



Talking to player characters

To talk in a normal tone

When you speak in a normal tone, anyone you can see can hear you.
1 Type a double quotation mark, and then type your message. For example, type “Happy hunting!
You do not need to end your message with a double quotation mark.
2 To send the message, press ENTER. Or click the Send Command Line button or click the right mouse button.

To address a character privately

When you address a character privately, only that character can hear you.

1 Type the character's name, followed by a comma, and then type your message. For example, Halifax, do you
have any succor scrolls?

2 To send the message, press ENTER. Or click the Send Command Line button or click the right mouse button.
To shout

When you shout, anyone within five steps of you can hear you, even if you cannot see them.

1 Type @ and then type your message. For example, if you wander away from your adventuring party, type
@Hey! Where is everyone?

2 To send the message, press ENTER. Or click the Send Command Line button or click the right mouse button.



Talking to non-player characters
Some of the non-player characters in the kingdom may have clues to adventuring in the kingdom.

To talk to a non-player character

b Click the character's |dentity box, and then type your message. For example, to say hello, click a
character's Identity box, and then type hello



Greeting characters
You can greet player characters and non-player characters.
To greet a character

1 Click the Action Commands pop-up menu, and then point to Greet.
2 Click the Initiate Action button.
3 Click the Identity box of the character you want to greet. The character receives a greeting message.



Hugging characters

Hugging a player character who has accidentally attacked another player character returns the color of the
offending character's Identity box from red to gray. Hugging a character or creature you have accidentally
targeted also removes the bull's-eye from the character or creature's Identity box.

To hug a character

1 Click the Action Commands pop-up menu, and then point to Hug.
2 Click the Initiate Action button.
3 Click the Identity box of the character you want to hug. The character receives a hug message.



Singing, dancing, and rolling on the floor with laughter

You can use the following commands to express yourself:

agree jostle ROFL* think
dance kiss scratch tickle
disagree laugh scream wink
growl mock sing yell
grumble pinch sneeze

holler prod spit

*roll on the floor laughing

To use a command on yourself
b Type | and then type the command. For example, to roll on the floor laughing, type | ROFL

To direct a command toward a character

1 Type I and then type the command. For example, to roll on the floor laughing, type | ROFL
2 Click the character's Identity box .



Adventuring in a party

Characters who explore the kingdom in parties share experience points and skill gains. For example, if one
member of a party slays a sanquin, each member of the party gets experience points. The highest-skilled
characters in the party get most of the experience. Each member of the party also gets part of the skill gain
toward their most-recently used skill.

Thieves who are members of adventuring parties contribute all their weapon experience to the party, but receive
thieving skill for half of their skill gain from Backstabbing.

Parties of four or more receive a skill-gain bonus. The larger the party, the greater the skill-gain bonus.

To reap the benefits of adventuring in a party, you must not be invisible, and you must stay within yelling

distance of the party creator. If you stray too far from the party creator, your experience is not contributed to the
party; instead, you alone receive it.

To create a party

b Type party create and the name of the party. For example, to create a party called Slayers, type party
create slayers

The party name can contain 3 to 14 letters or numbers.

To join a party
¥ Type party join and the name of the party. For example, to join a party called Slayers, type party join
slayers

To list the party members
¥ Type party list

To leave a party
b Type party leave

To eject a party member

Note You must be the creator of the party to eject a member.
¥ Type party eject and the name of the character. For example, to eject a character named Halifax, type
party eject Halifax

To break up a party

Note You must be the creator of the party to break it up.
b Type party break



Paging a player character

Paging is done from the conference room. When you are in the conference room, you can page a player
character in Kingdom of Drakkar, and if you are in the kingdom you can receive a page.

To page a player
b On the File menu, point to Quit to go to the conference room, and then use the Theater Help from the gold
toolbar.

To respond to a page
¥ On the File menu, point to Quit to go to the conference room, and then use the Theater Help from the gold
toolbar.

{button ,AL("Pagerinfo")} Related Topics



Turning the pager on and off

When you are in Drakkar, players in the conference room can page you. By default, the pager is enabled so that
other players can get in touch with you while you are in the kingdom. If you do not want to receive pages while
you are in the kingdom, disable the pager.

To turn on the pager

1 Click the Action Commands pop-up menu, and then point to Page enable.
2 Click the Initiate Action button.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.

To turn off the pager

1 Click the Action Commands pop-up menu, and then point to Page disable.
2 Click the Initiate Action button.
3 Press ENTER. Or click the Send Command Line button or click the right mouse button.

{button ,AL("Pagerinfo")} Related Topics



Types of Traders

There are three types of traders in the kingdom:

¥ Shopkeepers
Shopkeepers have established businesses with doors and counters. There are a variety of shops, such as
weapons shops, armor shops, alchemists, and drinking establishments. Merchandise (and prices) vary from
shop to shop, and you should be able to buy almost anything you need.

b Scroll Vendors
Scroll vendors stand in the busy areas of the kingdom and shout what they sell and how much they charge.
Scroll vendors sell a variety of scrolls imbued with psionic disciplines such as ProtAssault, Succor, Respirate,

and ProtStun.
b Questors

Questors sometimes rent shops and sometimes wander about the kingdom. They usually carry a valuable item
in one of their hands that they will trade you for what they request.

{button ,AL("TraderInfo")} Related Topics



To buy from a shopkeeper

1 Stand in front of the counter.

2 Click the shopkeeper’s Identity box. The shopkeeper appears. The items he or she sells are displayed on the
shelves. The cost of each item is beneath the item.

3 Drag the item you want to buy to your hand, sack, belt, or pouch.
4 Type the number of items you want to buy, or click Maximum.

If you click Maximum, the shopkeeper sells you as many items as will fit in the location you dragged the item
to (and have enough coins to buy). For example, if your sack is empty, the shopkeeper will sell you as many
bottles as will fit in your sack.



To sell to a shopkeeper

1 Stand in front of the counter.
2 Click the shopkeeper’s Identity box. The shopkeeper appears.

3 Drag the item you want to sell to the shopkeeper’s face. The shopkeeper places the appropriate amount of
gold in your sack.

Note To sell multiple items, press SHIFT, click on the items you want to sell, and then drag the last item to
the shopkeeper's face.



Having an item appraised

Having an item appraised might give you some idea of its worth, even if you don’t know what it is used for. For
example, if you find an interesting helm and don’t know whether you should sell it, you can have it appraised. If
it is worth more coins than a typical helm, it might have special powers.

To have an item appraised

1 Stand in front of the counter.

2 Click the shopkeeper’s Identity box. The shopkeeper appears.
3 Click the Show menu, and then point to Counter.

4 Drag the item you want to appraise to the Counter window.

5 Type the shopkeeper’s name, followed by a comma, and then type appraise and the item you want
appraised. For example, to have a shopkeeper named Ewok appraise a gem, type Ewok, appraise gem

Notes
b You can abbreviate the shopkeeper’s name to the first three letters.
b You must be specific about what an item is called. If you are holding a sword, you must specify whether it
is a shortsword, longsword, or other kind of sword.



Interacting with a questor

To interact with a questor

1 Stand on the guestor.
2 Click the questor’s Identity box. The questor appears.
3 Click the Discuss button. The questor tells you what to do.



To buy a scroll from a scroll vendor

1 Stand on the scroll vendor.
2 Click the scroll vendor’s Identity box. The scroll vendor appears.

3 Click the Discuss button. The scroll vendor places the scroll in your hand and removes the appropriate number
of coins from your sack.

{button ,AL("Succorinfo;Traderinfo")} Related Topics



Creating a succor twig
A succor twig quickly transports you from one location to another.
To create a succor twig from a succor scroll

1 Stand in the location you want to return to when you use the succor twig.
2 Hold the succor scroll in your right hand.

3 Click the Disciplines pop-up menu, and then point to Succor.
4 Click the Form Discipline button. The succor scroll crumbles to dust, and a succor twig appears in your hand.

{button ,AL("SuccorInfo")} Related Topics



To use a succor twig

b Drag the succor twig to the Terrain window. You will be whisked away to the location where you created the
succor twig.

{button ,AL("Succorinfo")} Related Topics



Using the bank
You can access your account from any of the many bank branches located throughout the kingdom.
To deposit coins into the bank

1 Stand in front of the counter.

2 Click the banker’s Identity box. The banker appears, and your account balance is shown.

3 Click the Deposit button.

4 Type the number of coins you want to deposit. The coins automatically move from your sack to your account.
5 To leave the bank, click Exit.

To withdraw coins from the bank

1 Stand in front of the counter.

2 Click the banker’s Identity box. The banker appears, and your account balance is shown.

3 Click the Withdraw button.

4 Type the number of coins you want to withdraw. The coins automatically move from your account to your sack.
5 To leave the bank, click Exit.



Making armor from a creature's carcass

The fur, feathers, and skin of some creatures can be made into strong armor if you take the creature's carcass to
the tanner. The tanner is in west Nork. Not all creature carcasses can be made into armor, and you must
participate in killing the creature in order to make armor from its carcass.

To make armor from a creature’s carcass

1 Stand on the tanner.
2 Drop the corpse on the ground.
3 Type the tanner’s name, followed by a comma, and then type make armor

If the corpse can be made into a robe or a vest, the tanner tells you when he has made your armor, and drops
it on the ground for you to pick up.



Having a gem encrusted in an item

You might have a gem encrusted into two similar items so that you can tell them apart. For example, if you have
two longswords that look exactly alike but one is enchanted, you might have a gem encrusted into the
enchanted longsword. The gem encruster is in southeast Nork.

To have a gem encrusted in an item

1 Stand on the gem encrusted.
2 Click the gem encruster’s Identity box. The gem encruster appears.
3 Click the Discuss button.

Note When an item is encrusted with a gem, you must hold the item in your hand and look at it to see the
gem.



Placing a bet with the gambler
You can wager for experience points by placing a bet with the gambler. The gambler is in east Nork.
To place a bet with the gambler

1 Stand on the gambler.

2 Drop the coins you want to wager onto the ground.

3 Click the gambler's Identity box, and then type gamble and a number from 1 to 10. For example, to bet on the
number five, type gamble 5
The gambler spins the wheel, and if it lands on the number you picked, you receive one experience point for
each coin you wagered, and you get to keep your coins. If the gambler doesn't spin your number, you still get
the experience points, but you lose your coins.



Swapping the items in your hands
Swap hands when you want to quickly move an item from one hand to the other without first moving one of

them to another location, such as your belt, pouch, or sack.

To swap the items in your hands
b Type swap



Wearing garments and jewelry

To see what you are wearing

» Click the Body, Disciplines, Ground button.
To wear garments and jewelry
» Drag the item to your face or body.

To remove garments and jewelry

1 Click the Body, Disciplines, Ground button.
2 Drag the item to a new location.



Searching a corpse
After you slay an opponent, you should search the corpse and take any gold, gems, weapons, garments, or other
treasure your opponent was carrying.

To search a corpse

1 Stand on the corpse.

2 Click the Ground button.

3 Press SHIFT, and then click the corpse in the left column of the Ground window. All corpses are searched and
their possessions appear in the Ground window.



Reading a scroll

One of your hands must be empty to read a scroll.
¥ Drag the scroll to your face.
The scroll appears in your hand and the contents of the scroll appear in the Narrative window. If the scroll is
imbued with a psionic discipline, the discipline appears in the Disciplines pop-up menu.



Drinking from a bottle or the terrain

To drink from a bottle
One of your hands must be empty to drink from a bottle.
b Drag the bottle to your face.
If the bottle contained only one ounce of fluid, it disappears after you drink from it.
To drink the first healing potion in your sack
» Click the Drink Healing Potion button.

If you have a healing potion in your sack, you drink it. If there is not a healing potion in your sack, you drink
the first healing potion in your pouch.

To drink from the terrain
¥ Stand in the water, and then type drink



Opening or closing a bottle

To open a bottle
» Hold the bottle in one of your hands, and then type open bottle

Open bottles spill if you neglect to close them before moving them to your sack, pouch, or other location.

To close a bottle
¥ Hold the bottle in one of your hands, and then type close bottle



Filling or emptying a bottle
To fill a bottle

Note A bottle must be empty before you can fill it.

1 Hold the bottle in one of your hands.

2 Stand in the water.

3 Click the Action Commands pop-up menu, and then point to Fill bottle.

4 Click the Initiate Action button.

5 Press ENTER. Or click the Send Command Line button or click the right mouse button.

To empty a bottle

Note A bottle must be open before you can empty it.

1 Hold the bottle in one of your hands.

2 Click the Action Commands pop-up menu, and then point to Empty bottle.

3 Click the Initiate Action button.
4 Press ENTER. Or click the Send Command Line button or click the right mouse button.



To break an item

1 Hold the item in one of your hands.
2 Type break and the name of the item you want to break. For example, to break a bottle, type break bottle



Memorizing a teleport location

You memorize a location you want to return to when you use the Teleport discipline. The name of the location
can be up to 10 letters long, and you can memorize up to 20 locations.

To memorize a teleport location

1 Stand in the location you want to return to when you use the Teleport discipline.
2 Click the Action Commands pop-up menu, and then point to Memorize.
3 Click the Initiate Action button. The word "memorize" appears on the command line.

4 On the command line, after the word "memorize," type a location name. For example, to memorize a location
on Yeti Island, you might type yetiisland



Forgetting a teleport location
You forget a teleport location you have remembered using the Memorize command.
To forget a teleport location

1 Click the Action Commands pop-up menu, and then point to Forget.

2 Click the Initiate Action button. The word "forget" appears on the command line.

3 On the command line, after the word "forget," type a memorized location name. For example, to forget a
location on Yeti Island, you might type yetiisland



To repeat the previous command
¥ Click the Repeat Command button.



Setting Macros

To set a new macro

1 Click the Macros menu, and then point to Set Macro.

2 In the dialog box, click an empty space, and then click OK.

3 In the Name text box, type a name for the macro. For example, to set a macro for the Swap command, type
swap

4 In the Macro text box, type the command to assign to the macro. For example, to use the Swap command,
type swap

5 In the Key text box, type the letter you want to assign to the macro. For example, if you are setting a macro for
the Swap command, you might type the letter s

6 Click the check box of the key (CTRL, ALT, or SHIFT) that you want to assign to the macro.

To use a macro

b Press the key combination you assigned to the macro, and then press ENTER. Or click the Send Command
Line button or click the right mouse button.

For example, if you set a macro of CTRL+S for the Swap command, press CTRL and S to display the word
"Swap" on the command line, and then press ENTER.
To edit a macro

1 Click the Macros menu, and then point to Set Macro.
2 In the dialog box, click a macro name, and then click OK.
3 Edit the name, macro, or key combination of the macro.



To turn auto carriage return on and off
1 On the Options menu, click Preferences.
2 Click the check box to turn auto carriage return on and off.

If there is a check in the box, the contents of the command line are automatically sent during combat. If there
is not a check in the box, you must press ENTER to send the contents of the command line during combat.



To turn auto append on and off

1 On the Options menu, click Preferences.
2 Click the check box to turn auto append on and off.

If there is a check in the box, you shout any text that is on the command line when you attack an opponent.

For example, if you are typing a message to another character and you attack an opponent, you attack and
shout your message.



To turn abridged combat messages on and off

1 On the Options menu, click Preferences.
2 Click the check box to turn abridged combat messages on and off.

If there is a check in the box, combat messages that indicated misses or blocks do not appear in the Narrative
window. If there is not a check in the box, full combat messages appear in the Narrative window.



To turn sound effects on and off
1 On the Options menu, click Preferences.
2 Click the check box to turn sound effects on and off.

If there is a check in the box, sound effects are turned on. If there is not a check in the box, sound effects are
turned off.

Note Sound effects can warn you of danger.



To turn music on and off

1 On the Options menu, click Preferences.
2 Click the check box to turn music on and off.

If there is a check in the box, music is turned on. If there is not a check in the box, music is not turned on.



To use the right mouse button to send commands
1 On the Options menu, click Preferences.
2 Click the check box to turn the right mouse button on and off.

If there is a check in the box, you can send commands by clicking the right mouse button rather than pressing
ENTER. If there is not a check in the box, the right mouse button does nothing.



To turn Tooltips on and off
1 On the Options menu, click Preferences.
2 Click the check box to turn Tooltips on and off.

If there is a check in the box, Tooltips display for the areas of the user interface. If there is not a check in the
box, Tooltips do not display.



To clean up open windows
b On the Options menu, click Clean up windows.
The Ground window, Sack window, Pouch window, Belt window, Locker window, Counter window, Body
window, and Disciplines window return to their default positions.



Attack

You can attack using any weapon in your right hand. If you are not holding a weapon, you attack with your bare
hands using martial skill. In order to attack with your hands and most weapons, you and your opponent must be
standing in the same spot.

To attack

1 Click the Attack Commands pop-up menu, and then point to Attack. The name of the command appears on the
button.

2 Click the Identity box of the opponent you want to attack.



Shoot

You can shoot using any weapon in your right hand. If you are not holding a weapon, you attack with your bare
hands using martial skill. In order to attack with your hands and most weapons, you and your opponent must be
standing in the same spot.

You shoot a bow by holding the bow in your right hand and leaving your left hand empty. You can also shoot a
bow using the Attack command.

To shoot

1 If you are shooting a bow, hold the bow in your right hand. Your left hand must be empty to draw the bow.

2 Click the Attack Commands pop-up menu, and then point to Shoot. The name of the command appears on the
button.

3 Click the Identity box of the opponent to shoot.



Throw right or left
You can throw any weapon or item at an opponent.
To throw the weapon in your right hand

1 In your right hand, hold the weapon you want to throw.

2 Click the Attack Commands pop-up menu, and then point to Throw Right At. The name of the command
appears on the button.

3 Click the Identity box of the opponent you want to throw the weapon at.
To throw the weapon in your left hand

1 In your left hand, hold the weapon you want to throw.

2 Click the Attack Commands pop-up menu, and then point to Throw Left At. The name of the command appears
on the button.

3 Click the Identity box of the opponent you want to throw the weapon at.



Kick
All characters can kick. The amount of damage caused by kicking depends on your martial skill. In order to kick,
you and your opponent must be standing in the same spot.

To kick

1 Click the Attack Commands pop-up menu, and then point to Kick. The name of the command appears on the
button.

2 Click the Identity box of the opponent you want to kick.



Jumpkick
Martial Artists who attain the martial skill level of Red Belt can leap toward their opponents and kick them. The
distance of a jumpkick depends on the Martial Artist's skill level.

To jumpkick

1 Click the Attack Commands pop-up menu, and then point to Jumpkick. The name of the command appears on
the button.

2 Click the Identity box of the opponent you want to jumpkick.



Sweep

Martial Artists who attain the martial skill level of Brown Belt can sweep multiple opponents who are standing in
their location. The Sweep command inflicts less damage than the Attack, Kick, or Jumpkick commands, but it
may kill a number of weak creatures more quickly than if you attacked them individually. The number of
opponents wounded or slain depends on the character’s martial skill level. Sweeping attacks everything in the
character’s location, even allies. Martial Artists who attain the martial skill level of Black Belt, sixth degree, have
a greater chance of striking every creature in their location.

To sweep

1 Click the Attack Commands pop-up menu, and then point to Sweep. The name of the command appears on the
button.

2 Click the Initiate Attack button.



Stab

You can stab using any weapon in your right hand. If you are not holding a weapon, you attack with your bare
hands using martial skill. In order to attack with your hands and most weapons, you and your opponent must be
standing in the same spot.

To stab

1 Click the Attack Commands pop-up menu, and then point to Stab. The name of the command appears on the
button.

2 Click the Identity box of the opponent you want to stab.



Backstab

Thieves who attain the thievery skill level of Adept can Hide in the shadows and surprise an opponent with a stab
in the back. Thieves must be in hiding to attempt to backstab. A successful backstab inflicts more damage than
a normal attack because the element of surprise adds to a creature’s vulnerability.

To backstab

1 Click the Attack Commands pop-up menu, and then point to Backstab. The name of the command appears on
the button.

2 Click the Identity box of the opponent you want to backstab.



Steal from

To steal from a character

1 Click the Attack Commands pop-up menu, and then point to Steal from. The name of the command appears on
the button.

2 Click the Identity box of the opponent you want to steal from.

To steal a particular item from a character

¥ Type steal and then type the name of the item you want to steal followed by the name of the character.
For example, to steal a gem from Halifax, type steal gem from Halifax



Hide

Thieves hide in concealing terrain or the shadows next to walls so they can Backstab an opponent. How
successfully Thieves hide depends on their thievery skill and the size of the items in their hands. Thieves
carrying large weapons, such as halberds and polearms or hammers are often unable to hide. Thieves with high
thievery skill can stand closer to creatures without being seen. Thieves who are wounded often have difficulty
finding a good shadow. Thieves Reveal themselves to come out of hiding.

To hide

1 Stand next to a wall or other concealing terrain.

2 Click the Action Commands pop-up menu, and then point to Hide.

3 Click the Initiate Action button.

4 Press ENTER. Or click the Send Command Line button or click the right mouse button.



Mug

True Thieves who attain the thievery skill level of Swift can move toward, scuffle with, and steal an item or coins
from an opponent in a single motion by mugging them. Thieves must Hide before they can Mug a creature or
character.

To mug

1 Click the Attack Commands pop-up menu, and then point to Mug. The name of the command appears on the
button.

2 Click the Identity box of the opponent you want to mug.



Reveal
Thieves reveal themselves when they want to come out of hiding. Thieves who attain the thievery skill level of
Master Thief can use the Reveal command to bring other thieves out of hiding.

To reveal
b Type reveal



b

Traps

True Thieves can set and disarm traps. You gain experience points if your trap activates and slays a creature
when you are online. You are responsible for any traps you place, and killing non-hostile creatures with traps is
reflected in your alignment.

Traps of various strengths are for sale in the Thieves' Guild and from some shady merchants in the kingdom.
If you drop a trap that has not been set, the trap is destroyed. However, Thieves do not set off their own traps,
so you can pick them up and set them in a new location without worry.

To disguise a trap
Hold the item you want to disguise the trap as in your left hand before you set the trap. For example, to

disguise a trap as a gem, hold a gem in your left hand.

b

To set a trap
Type trap and then type the power and direction and parameters of the trap.

For example, to set a trap north of where you are standing, type trap n
To set a power 10 trap north of where you are standing, type trap 10 n

To set a power 10 trap that is north of where you are standing and that is tripped by a character or creature
carrying a gem, type trap 10 n carrying



Power

The trap can be any power up to your thievery skill level. If you do not specify a power, the trap is full-power
(equivalent to your thievery skill level).



Direction

The trap can be set in the following directions: n, s, e, and w.



b

Parameters

Carrying

The trap is activated by any character or creature carrying the item the trap is disguised as. For example, if
the trap is disguised as a gem, any character or creature carrying a gem activates the trap.

Not Carrying
The trap is activated by any character or creature not carrying the item the trap is disguised as. For example,
if the trap is disguised as a scroll, any character or creature not carrying a scroll activates the trap.

Wearing
The trap is activated by any character or creature wearing the item the trap is disguised as. To use this
parameter, the item must be a helm, necklace, armor, cloak, or boots. For example, if the trap is disquised as
a helm, any character or creature wearing a helm activates the trap.

Not Wearing
The trap is activated by any character or creature not wearing the item the trap is disguised as. To use this
parameter, the item must be a helm, necklace, armor, cloak, or boots. For example, if the trap is disguised as
a cloak, any character or creature not wearing a cloak activates the trap.



Disarm
All characters with some degree of thievery skill, not just Thieves, can attempt to disarm a trap. Thieves do not
need to disarm their own traps; they can simply pick them up.

To attempt to disarm a trap
b Type disarm and then type the direction of the trap. For example, to disarm a trap one step north of where

you are standing, type disarm n
Valid directions are n, s, e, w, ne, nw, se, and sw.

Note An unsuccessful attempt to disarm a trap may activate it.



Charge

Fighters, Paladins, and Barbarians who attain the weapon skill level of Adept can move toward and attack an
opponent in a single motion. The distance of the charge depends on the character’s skill level. You must have a
weapon in your right hand to charge.

To charge

1 Click the Attack Commands pop-up menu, and then point to Charge. The name of the command appears on
the button.

2 Click the Identity box of the opponent you want to charge.



Focus Strike

Paladins who attain the weapon skill level of High Warrior can focus their energy away from defense and into a
single powerful blow, which often penetrates armor more effectively than normal combat strikes.

To focus strike
b Type focus strike and then click the Identity box of your opponent.



Focus Blindstrike

Paladins who attain the weapon skill level of Specialist can focus their energy when blinded or unable to see in
the darkness to strike a random opponent where the Paladin is standing. Highly skilled Paladins can strike a
specific opponent.

To focus a random blindstrike
¥ Type focus blindstrike

To focus a specific blindstrike
b Type focus blindstrike and then click the |dentity box of your opponent.



Focus Multistrike

Paladins who attain the weapon skill level of Beholder of the Art can focus their energy to strike multiple
creatures at the same time. The number of creatures hit depends on the Paladin’s number of attacks.

To focus multistrike
b Type focus multistrike



Focus Parry
Paladins who attain the weapon skill level of Beholder of the Art can focus their energy into a complete defense
to fend off blows. The defensive position is maintained until you use another command.

To focus parry
b Type focus parry



Focus Boost

Paladins who attain the weapon skill level of Initiate of Stance can slip into a trance that boosts their strength
and agility by two points.

To focus boost
b Type focus boost



Focus Powerstrike

Paladins who attain the weapon skill level of Student of Stance can focus their energy away from defense and
into a single devastating blow.

To focus powerstrike
b Type focus powerstrike and then click the Identity box of your opponent.



b

Focus Defend

Paladins who attain the weapon skill level of Master of Stance can focus their own defensive energy toward the
defense of another character. This decreases the Paladin’s own defenses and may cause him or her to fall prey

to the same opponent.

To focus defend
Type focus defend and then click the Identity box of the character to defend.



b

Focus Superboost

Paladins who attain the weapon skill level of Initiate of Form can slip into a trance that boosts their strength and
agility by five points and increases their move rate by one step. Focus Superboost is stressful and may require
concentration time.

To focus superboost
Type focus superboost



Focus Armorstrike

Paladins who attain the weapon skill level of Student of Form can focus their energy into a combat strike that
damages the opponent's armor and weapon.

To focus armorstrike
b Type focus armorstrike and then click the Identity box of your opponent.



b

Focus Ultraboost

Paladins who attain the weapon skill level of Master of Form can slip into a trance that boosts their strength and
agility by eight points and increases their move rate by two steps. Focus Ultraboost is very stressful and may
require much concentration.

To focus ultraboost
Type focus ultraboost



Focus Maxstrike

Paladins who attain the weapon skill level of Initiate of Style can focus their energy away from defense and
toward a single awe-inspiring blow that often inflicts the maximum amount of damage a weapon can cause.

To focus maxstrike
b Type focus maxstrike and then click the Identity box of your opponent.



b

Focus Disarm

Paladins who attain the weapon skill level of Student of Style can focus their energy to tear the weapon from an
opponent’s hands and throw it to the ground. Disarming an opponent is very difficult and may require several
attempts.

To focus disarm
Type focus disarm and then click the Identity box of your opponent.



Focus Pierce
Paladins who attain the weapon skill level of Master of Style can focus their energy away from defense and into a
single thrust that pierces armor and other physical protection and causes severe damage to an opponent.

To focus pierce
b Type focus pierce and then click the Identity box of your opponent.



Chi Sweep
Martial Artists who attain the martial skill level of Master can summon their energy away from defense to

overcome darkness, blindness, or invisibility to attack opponents.

To chi sweep
b Type chi sweep



Chi Minorshield

Martial Artists who attain the martial skill level of Grand Master can summon their energy to produce a shield of
protection against psionic and physical damage. Chi Minorshield requires concentration.

To chi minorshield
b Type chi minorshield



Chi Wallbreak

Martial Artists who attain the martial skill level of Beholder of the Art can summon their energy in a particular
direction to break down walls. Chi Wallbreak is very stressful.
To chi wallbreak
b Type chi wallbreak and then type the direction of the wall. For example, to break a wall to the north, type
chi wallbreak n



Chi Ironfist
Martial Artists who attain the martial skill level of Seeker of the Sash can summon a portion of their defensive

energy into a single powerful blow, which often penetrates armor more effectively than normal combat strikes.

To chi ironfist
b Type chi ironfist and then click the Identity box of your opponent.



b

Chi Minorpool

Martial Artists who attain the martial skill level of Bronze Sash can slip into a trance that pools their internal
energy into temporary health points that temporarily raise the Martial Artist to a level 50 percent above their

maximum health points.

To chi minorpool
Type chi minorpool



Chi Jumpstrike
Martial Artists who attain the martial skill level of Bronze Sash, second degree, can summon their energy from

defense to propel themselves through the air and punch an opponent.

To chi jumpstrike
b Type chi jumpstrike and then click the Identity box of your opponent.



Chi Shield

Martial Artists who attain the martial skill level of Bronze Sash, third degree, can summon their energy into a
more powerful version of the Minorshield command that produces a solid damage shield around the Martial
Artist, and which resists physical and psionic damage. The concentration time to produce this effect is nearly five
rounds. The channeling of internal energy into an external force in this way causes great physical stress upon the
Martial Artist.

To chi shield
b Type chi shield



b

Chi Powersweep

Martial Artists who attain the martial skill level of Bronze Sash, fourth degree, can summon their energy into a
devastating attack on multiple targets in the immediate area of the Martial Artist. The targets need not be seen

to be affected.

To chi powersweep
Type chi powersweep



Chi Pool

Martial Artists who attain the martial skill level of Bronze Sash, fifth degree, can summon their energy to
temporarily boost their health points to twice their maximum health.

To chi pool
b Type chi pool



Chi Rapidpunch
Martial Artists who attain the martial skill level of Bronze Sash, sixth degree, can summon their energy into a
fury of successive punches targeted against a single opponent. Each punch is a separate attack.

To chi rapidpunch
b Type chi rapidpunch and then click the Identity box of your opponent.



Chi Majorshield

Martial Artists who attain the martial skill level of Bronze Sash, seventh degree, can summon their energy into
the ultimate in personal shields, which provides 60 points of protection against each psionic or physical attack.
The concentration time required to produce a majorshield is often more than seven rounds. The energy directed
away from the Martial Artist's life force into the shield is substantial.

To chi majorshield
b Type chi majorshield



b

Chi Majorpool

Martial Artists who attain the martial skill level of Bronze Sash, eighth degree, can slip into a trance that
produces a temporary health value three times that of the Martial Artist's maximum health points. The
concentration time for this effect is often as high as 12 rounds.

To chi majorpool
Type chi majorpool



Chi Deathtouch

Martial Artists who attain the martial skill level of Silver Sash can summon their energy into the most-feared Chi
art form in which the Martial Artist forgoes one permanent point of constitution in a chilling death attack on the
specified target. Creatures with less than half the skill level of the Martial Artist are slain outright, and others
suffer from one-third to three times their maximum health in damage. Creatures with levels higher than the skill
level of the Martial Artist are subjected to a powerful form of the Ironfist discipline. There are no aging effects to
this discipline.

To chi deathtouch
b Type chi deathtouch and then click the Identity box of your opponent.



About psionic disciplines

A psionic discipline is a concentration of mental energy that produces an effect, such as inflicting damage,
providing protection, healing wounds, or providing special abilities. All characters are capable of forming psionic
disciplines from psionically imbued items such as scrolls and rings. However, Mentalists, Healers, and Thieves
are capable of using their mental energy to form psionic disciplines without having to use psionically imbued
items.

Each psionic discipline has an associated Psionic Energy Cost, Stress Factor, and a possible Side Effect.
Psionicists who use their innate ability to form a discipline must deal with all three components of the discipline.
If you form a discipline from an item, you do not expend any psionic energy or experience any stress. However,
you do experience any side effect that is associated with the discipline.

Psionic disciplines have a limited duration depending on the skill level of the psionicist forming the discipline.
Damage-inflicting disciplines usually cause increasing amounts of damage according to how high the psionicist’s
skill level is. Some disciplines can be formed on yourself and others. Some disciplines strike or affect a single
target, and some affect a larger area. Be careful when you form disciplines that affect larger areas, because you
may inflict damage on non-hostile creatures, your allies, or yourself.

{button ,AL("DspInfo")} Related Topics



To form a psionic discipline on yourself

If you are forming the discipline from a psionically imbued item, hold it in either one of your hands.

1 Click the Disciplines pop-up menu, and then point to the discipline you want to form. The discipline then
appears on the button. For example, to form the Respirate discipline, point to Respirate, and the word
"Respirate" appears on the button.

2 Click the Form Discipline button. The word "Form" and the name of the discipline appear on the command line.
For example, if you are forming the Respirate discipline, "Form Respirate" appears on the command line.

3 Press ENTER. Or click the Send Command Line button or click the right mouse button. The discipline forms on
you.



To form a psionic discipline on others

If you are forming the discipline from a psionically imbued item, hold it in either one of your hands.

1 Click the Disciplines pop-up menu, and then point to the discipline you want to form. The discipline then
appears on the button. For example, to form the Respirate discipline, point to Respirate and the word
"Respirate" appears on the button.

2 Click the Identity box of the character you want to form the discipline on. For example, to form the Respirate
discipline on Halifax, click Halifax’s Identity box.



Absorption discipline

Psionic Energy Cost: 20
Stress Factor: Low

Protects against psionic attacks by absorbing psionic energy. You can form this discipline on yourself or others.

{button ,AL("DsplInfo")} Related Topics



AcidBreath discipline

Psionic Energy Cost: 10
Stress Factor: Low

Creates a cloud of highly corrosive acid around a creature or in a location.

{button ,AL("DsplInfo")} Related Topics



Assault discipline

Psionic Energy Cost: 10
Stress Factor: Low

Short-circuits a creature’s brain and nervous system, inflicting considerable damage according to the skill level
of the psionicist.

{button ,AL("Dsplnfo;ProtAssault")} Related Topics



Atone discipline

Psionic Energy Cost: 35
Stress Factor: Moderate
Side Effect: Permanent health damage

Attempts to draw a character one degree closer to an alignment of true good. Only highly skilled psionicists are
able to purify characters, such as Paladins, who want to pursue other professions. The psionicist forming this
discipline suffers permanent damage, as it requires a great deal of concentration to reorient another character's
moral compass.

{button ,AL("DspInfo")} Related Topics



AutoHeal discipline

Psionic Energy Cost: 50
Stress Factor: High

Automatically forms the Heal discipline on a character whose current health points are less than one-fifth of
maximum health points. For example, if your maximum health points are 100 and you suffer 81 points of
damage, the AutoHeal discipline goes into effect. However, if you have 100 health points and suffer 120 points
of damage, you are dead and AutoHeal does not work. You can form this discipline on yourself or others.

{button ,AL("DsplInfo")} Related Topics



Blast discipline

Psionic Energy Cost: 20
Stress Factor: Low

Creates an explosion that burns flesh, shatters small objects, and destroys non-reinforced walls in an area.

{button ,AL("DsplInfo")} Related Topics



Blind discipline

Psionic Energy Cost: 10
Stress Factor: Low

Temporarily blinds a creature.

{button ,AL("Dsplnfo;Vision")} Related Topics



Charm discipline

Psionic Energy Cost: 30
Stress Factor: Moderate

Causes a creature to temporarily function under the psionicist’s control.
To form the Charm discipline

If you are forming the discipline from a psionically imbued item, hold it in either one of your hands.
1 Click the Disciplines pop-up menu, and then point to Charm. The discipline then appears on the button.
2 Click the Identity box of the opponent you want to form the discipline on.

3 When the creature is charmed, click the creature's Identity box, and then type the action you want the
creature to take. For example, type fight orc to make a creature fight an orc, or type take bottle to make a
creature pick up a bottle.

{button ,AL("DspInfo")} Related Topics



Confusion discipline

Psionic Energy Cost: 25
Stress Factor: Low

Causes a group of hostile creatures to fly into a rage and attack random targets and one another. The number of
creatures afflicted depends on the skill level of the psionicist and the experience level of the creatures.

{button ,AL("DspInfo")} Related Topics



CritCure (critical cure) discipline

Psionic Energy Cost: 30
Stress Factor: High
Side Effect: Permanent health damage

Restores a dead character to life. The exertion of forming the CritCure discipline often damages the Healer
forming the discipline.

{button ,AL("DspInfo")} Related Topics



Darkness discipline

Psionic Energy Cost: 10
Stress Factor: Low

Temporarily creates darkness in an area around a creature or location.

{button ,AL("Dsplnfo;Light")} Related Topics



Detect discipline

Psionic Energy Cost: 10
Stress Factor: Low

Creates a glowing outline around all secret doors within the character’s view. You can form this discipline on
yourself or others.

{button ,AL("DspInfo")} Related Topics



Detox discipline

Psionic Energy Cost: 10
Stress Factor: Low

Neutralizes poison. You can form this discipline on yourself or others.

{button ,AL("Dsplnfo;Poison")} Related Topics



Disintegrate discipline

Psionic Energy Cost: 10
Stress Factor: High

Destroys all walls and all items on the ground within the character’s view.

{button ,AL("DsplInfo")} Related Topics



Door discipline

Psionic Energy Cost: 10
Stress Factor: Moderate

Creates a door in wood and stone walls and in some types of rock.

{button ,AL("DsplInfo")} Related Topics



EarthCrush discipline

Psionic Energy Cost: 100
Stress Factor: Very High

Causes the earth to crest like a wave and crash down upon all creatures in a small area.

{button ,AL("DsplInfo")} Related Topics



Enchant discipline

Psionic Energy Cost: 30
Stress Factor: Moderate

Psionically removes any flaws from a weapon and increases its combat bonus by one each time the discipline is
formed. The discipline can usually only be formed up to three times on a weapon, but highly skilled psionicists
may exceed this limit.

{button ,AL("DspInfo")} Related Topics



EnMiss (energy missile) discipline

Psionic Energy Cost: 5
Stress Factor: Low

Electrifies a creature with a powerful jolt of psionic energy.

{button ,AL("DsplInfo")} Related Topics



EnergyShield discipline

Psionic Energy Cost: 20

Stress Factor: Low

Creates a temporary psionic shield around a character that provides protection from psionic attack. You can form
this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



EnergySpear discipline

Psionic Energy Cost: 35
Stress Factor: Moderate

Creates a piercing shaft of psionic energy that may stun as well as damage a creature.

{button ,AL("DsplInfo")} Related Topics



FeatherFall discipline

Psionic Energy Cost: 30
Stress Factor: Low

Allows a character to fall a great distance without damage. You can form this discipline on yourself or others.

{button ,AL("DsplInfo")} Related Topics



FindFriendly discipline

Psionic Energy Cost: 30
Stress Factor: Moderate

Teleports the nearest friendly creature to where you are standing. The creature does not obey your every
command, but fights alongside you. Highly skilled psionicists can beckon more powerful creatures. The length of
time the creature remains to fight also depends on the psionicist’s skill level.

{button ,AL("DspInfo")} Related Topics



FireBall discipline

Psionic Energy Cost: 10
Stress Factor: Low

Creates a ball of fire that causes considerable damage to a targeted area.

{button ,AL("Dsplnfo;ProtFire")} Related Topics



FireBreath discipline

Psionic Energy Cost: 50
Stress Factor: Low

Creates a flame that causes significant damage in a large area.

{button ,AL("Dsplnfo;ProtFire")} Related Topics



FireStorm discipline
Psionic Energy Cost: 25
Stress Factor: Moderate

Causes a small area to spontaneously combust, creating a devastating fire against which most forms of fire
protection have little effect.

{button ,AL("Dsplnfo;ProtFire")} Related Topics



Haste discipline

Psionic Energy Cost: 25
Stress Factor: Very High
Side Effect: Permanent health damage

Doubles a character’s move rate and number of attacks. Some actions, such as resting or trading with
shopkeepers, still occur at normal speed. You can form this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



Heal discipline

Psionic Energy Cost: 20
Stress Factor: Low

Heals a character of almost all damage. You can form this discipline on yourself or others.

{button ,AL("Dsplnfo;AutoHeal")} Related Topics



IceBreath discipline

Psionic Energy Cost: 55
Stress Factor: Low

Creates a cloud of icy vapor that causes severe damage to any creature in a large area.

{button ,AL("Dsplnfo;Protice")} Related Topics



IceStorm discipline

Psionic Energy Cost: 15
Stress Factor: Moderate

Creates a storm of hail and freezing rain that causes significant damage to any creature in an area.

{button ,AL("Dsplnfo;Protice")} Related Topics



InfraVision (infrared vision) discipline

Psionic Energy Cost: 25
Stress Factor: Low

Allows a character to see in even the darkest conditions by displaying most creatures and terrain in the infrared
spectrum. You can form this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



Illusion discipline

Psionic Energy Cost: 25

Stress Factor: Moderate

Creates the illusion that the terrain in a small area has the qualities of water, ice, fire, a wall, a path, a bridge, or
emptiness.

To form an illusion

b Type form illusion and then type the effect you want to create, and the direction from where you are
standing that you want it to happen. For example, to create a wall to the north, type form illusion wall n

{button ,AL("DspInfo")} Related Topics



Imbue discipline

Psionic Energy Cost: 30
Stress Factor: Moderate

Recharges a psionically imbued item with psionic energy proportional to the skill level of the psionicist. The
psionic energy cost to imbue an item is the same whether the item is fully charged or mostly depleted of energy.
The number of charges that can be imbued into an item depends on the quality of the item and the psionicist’s
skill level. Only disciplines gained at half of the psionicist’s current skill level can be imbued in items.

To recharge an imbued item
b Hold the item in your right hand, and then type form imbue

To imbue a twig with a discipline

Mentalists who attain the psionics skill level of Defier of Vision can imbue wooden twigs of exceptional quality
with new disciplines. Wooden twigs of this caliber are available from the Healer's Guild in the Healer Trainer's
shop in Nork.
b Type form imbue and then type the name of the discipline to imbue. For example, to imbue a twig with
the Firestorm discipline, type form imbue firestorm

{button ,AL("DspInfo")} Related Topics



Light discipline

Psionic Energy Cost: 10
Stress Factor: Low

Illuminates an area. Counteracts the Darkness discipline and may break the Hide discipline of nearby Thieves.

{button ,AL("DsplInfo;Darkness")} Related Topics



Lightning discipline

Psionic Energy Cost: 15
Stress Factor: Low

Creates a bolt of lightning.

{button ,AL("DsplInfo")} Related Topics



Liminv (limited invisibility) discipline

Psionic Energy Cost: 10
Stress Factor: Low

Makes a character invisible to most creatures, even if the character takes damage. However, the character
becomes immediately visible if he or she inflicts damage. You can form this discipline on yourself or others. The
duration of this discipline is proportional to the psionicist’s skill level if formed on others, and unlimited if formed
on yourself.

{button ,AL("DsplInfo")} Related Topics



Mend discipline

Psionic Energy Cost: 5

Stress Factor: Low

Cures minor damage. The amount of damage mended is proportional to the psionicist’s skill level. You can form
this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



PassWall discipline

Psionic Energy Cost: 20
Stress Factor: Moderate

Allows a character to pass through walls and some types of rock. The duration of the discipline is proportional to
the psionicist’s skill level. Be careful that you are not inside something solid when the discipline depletes. You
can form this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



Poison discipline

Psionic Energy Cost: 20
Stress Factor: Low
Turns a creature’s blood to poison. The toxicity and duration of the poison depend on the psionicist’s skill level.

{button ,AL("DsplInfo;Detox")} Related Topics



PowerWord Death discipline

Psionic Energy Cost: Base 100
Stress Factor: Very High

Allows psionicists to funnel their psionic energy into a powerful one-word vocal assault that inflicts grave
damage, according to the skill level of the psionicist, upon all visible hostile creatures. Allies and friendly
creatures are not affected.

{button ,AL("DspInfo")} Related Topics



PowerWord Heal discipline

Psionic Energy Cost: Base 100
Stress Factor: Very High

Allows psionicists to funnel their psionic energy into a powerful one-word command that heals the psionicist and
all visible allies afflicted with poison, blindness, or physical damage.

{button ,AL("DspInfo")} Related Topics



PowerWord Stun discipline

Psionic Energy Cost: Base 100
Stress Factor: Very High

Allows psionicists to funnel their psionic energy into a powerful one-word vocal assault that stuns all visible
hostile creatures. Allies and friendly creatures are not affected.

{button ,AL("DspInfo")} Related Topics



ProtAssault (protection from assault) discipline

Psionic Energy Cost: 40
Stress Factor: Low

Creates an energy shield around a character’s mind to protect it against damage from the Assault discipline. You
can form this discipline on yourself or others.

{button ,AL("DsplInfo;Assault")} Related Topics



ProtFire (protection from fire) discipline

Psionic Energy Cost: 10
Stress Factor: Low

Creates a fire-resistant shield around a character. You can form this discipline on yourself or others.

{button ,AL("Dsplnfo;FireBall;FireBreath;FireStorm")} Related Topics



Protice (protection from ice) discipline

Psionic Energy Cost: 25
Stress Factor: Low

Creates an ice-resistant shield around a character. You can form this discipline on yourself or others.

{button ,AL("Dsplnfo;lceBreath;lceStorm")} Related Topics



ProtStun (protection from stun) discipline

Psionic Energy Cost: 30
Stress Factor: Low

Creates a stun-resistant shield around a character. You can form this discipline on yourself or others.

{button ,AL("DsplInfo;Stun")} Related Topics



Push discipline

Psionic Energy Cost: 20
Stress Factor: Low

Moves a creature a step or two in a random direction. Useful for pushing hostile creatures over cliffs or for
pushing stunned allies out of danger.

{button ,AL("DspInfo")} Related Topics



Respirate discipline

Psionic Energy Cost: 20
Stress Factor: Low

Allows you to walk across water at your normal move rate, rather than one step at a time. You can form this
discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



Reveal discipline

Psionic Energy Cost: 10
Stress Factor: Low

Allows a character to view items through most types of natural cover, such as forest, water, and ice. You can
form this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



Scry discipline
Psionic Energy Cost: 25
Stress Factor: Low

Allows a character to see through the eyes of another player character. The character whose vision is being
borrowed does not need to be visible to the character forming the discipline.

{button ,AL("DspInfo")} Related Topics



Sense discipline

Psionic Energy Cost: 10
Stress Factor: Low

Allows a character to sense the special properties of an item. High-level psionicists are able to tell whether an
item has been psionically imbued with the Imbue discipline, as well as which discipline an item is imbued with,
how many charges it contains, and even the location a succor twig returns to.

{button ,AL("DspInfo")} Related Topics



Stun discipline

Psionic Energy Cost: 15
Stress Factor: Low

Temporarily stuns a creature and prevents it from taking any action. A few creatures are immune to this
discipline. Stuns cannot be extended through additional stuns.

{button ,AL("Dsplnfo;ProtStun")} Related Topics



Succor discipline

Psionic Energy Cost: 15
Stress Factor: Low

Creates a succor twig that, when dropped, transports a character back to the location where the succor twig was
created.

{button ,AL("Dsplnfo;Succorinfo")} Related Topics



Teleport discipline

Psionic Energy Cost: 50
Stress Factor: High

Teleports a character to a location he or she has memorized using the Memorize command. Teleportation
requires a great deal of effort and may take several uninterrupted rounds. The energy cost is charged when the
Teleport discipline is formed, not when the location is memorized. Be aware that some teleporting devices and
portals may confuse or erase memorized locations. For this reason, most high-level Mentalists use disciplines
rather than relying on established portals.

To teleport

b After memorizing a location, type form teleport and then type the location you memorized. For example,
to teleport to a location called griffonlair, type form teleport griffonlair

{button ,AL("DspInfo")} Related Topics



Transmute discipline

Psionic Energy Cost: 10
Stress Factor: Low

Changes an item on the ground into gold coins. Items held by living characters and creatures are not
transmuted. High skill may be required to transmute powerful items.

{button ,AL("DspInfo")} Related Topics



TrapSack discipline

Psionic Energy Cost: 50
Stress Factor: Moderate

Envelops a character’s sack in a protective energy barrier that prevents thieves from Stealing items and coins.
You can form this discipline on yourself or others.

{button ,AL("DspInfo")} Related Topics



Vision discipline

Psionic Energy Cost: 10
Stress Factor: Low

Restores the vision of a character afflicted by the Blind discipline. You can form this discipline on yourself or
others.

{button ,AL("DspInfo;Blind")} Related Topics



Player character

A player character represents a player.



Non-player character

A non-player character permanently inhabits the kingdom.



Hostile

A hostile character or creature will try to kill you.



Non-hostile

A non-hostile creature or character will not threaten you unless you attack first.



Psionicist

A psionicist can use mental energy to form psionic disciplines. Mentalists, Healers, and Thieves are psionicists.



Psionically imbued

A psionically imbued item is charged with a psionic discipline, which you can form as if you were a psionicist.



True

A true member of a profession develops only those skills related to a dedicated profession. For example, a true
Mentalist survives in the kingdom using only psionics.



Move rate

Your move rate indicates how many steps you can take at once. For example, if your move rate is three and you
click a location six steps from where you are standing, you will move three steps in the direction you clicked. To
display your move rate, type list stats



Number of attacks

Your number of attacks indicates how many times you can strike at an opponent in a single round. For example,
if your number of attacks is two, you can strike an opponent twice in a single round.



Attune

Some items attune to your character when you pick them up or wear them. If you feel a tingling from an item, it

has probably attuned to you. Once an item has attuned to you, other characters cannot use or wear the item,
except the other characters on your MPG-Net account.



Psionic energy cost

Psionic energy cost is the amount of psionic energy required to form a discipline.



Stress factor

Stress factor is the amount of stress you incur from forming a discipline.



Side effect

Side effect is a secondary result of forming a discipline.



Chi

True Martial Artists can summon their inner energy (or Chi) to perform great feats during combat.
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Disciplines pop-up menu

The Disciplines pop-up menu is below your left hand.
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Action Commands pop-up menu

The Action Commands pop-up menu is below the Disciplines pop-up menu beneath your left hand.
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Attack Commands pop-up menu

The Attack Commands pop-up menu is below your right hand.
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Weapon skill levels

Unskilled
Clumsy
Familiar
Student
Practiced
Dedicated
Skilled
Experienced

Proficient
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Longsword skill levels

Unskilled
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Familiar
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Mace skill levels

0 Unskilled

11
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20
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11
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15
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17
18
19
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Prodigy
Brilliant
Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist
Beholder of the Art

Prodigy
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Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist
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Master

High Master
Grand Master
Warrior

High Warrior
Specialist

Beholder of the Art

Prodigy

22
23
24
25
26
27
28
29
30

22
23
24
25
26
27
28
29
30

22
23
24
25
26
27
28
29
30

22

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
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Clumsy
Familiar
Student
Practiced
Dedicated
Skilled
Experienced
Proficient
Practitioner

Expert

Staff skill levels
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Unskilled
Clumsy
Familiar
Student
Practiced
Dedicated
Skilled
Experienced
Proficient
Practitioner

Expert

12
13
14
15
16
17
18
19
20
21

11
12
13
14
15
16
17
18
19
20
21

Brilliant
Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist

Beholder of the Art

Prodigy
Brilliant
Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist

Beholder of the Art

Two-handed weapon skill levels
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Unskilled
Clumsy
Familiar
Student
Practiced
Dedicated
Skilled
Experienced
Proficient
Practitioner

Expert

Polearm skill levels

0
1
2

Unskilled
Clumsy

Familiar

11
12
13
14
15
16
17
18
19
20
21

11
12
13

Prodigy
Brilliant
Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist
Beholder of the Art

Prodigy
Brilliant

Incredible

23
24
25
26
27
28
29
30

22
23
24
25
26
27
28
29
30

22
23
24
25
26
27
28
29
30

22
23
24

Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance

Master of Stance



3 Student 14
4 Practiced 15
5 Dedicated 16
6 Skilled 17
7 Experienced 18
8 Proficient 19
9 Practitioner 20
10 Expert 21

Dagger skill levels

0 Unskilled 11
1 Clumsy 12
2 Familiar 13
3 Student 14
4 Practiced 15
5 Dedicated 16
6 Skilled 17
7 Experienced 18
8 Proficient 19
9 Practitioner 20
10 Expert 21

Axe skill levels

0 Unskilled 11
1 Clumsy 12
2 Familiar 13
3 Student 14
4 Practiced 15
5 Dedicated 16
6 Skilled 17
7 Experienced 18
8 Proficient 19
9 Practitioner 20
10 Expert 21

Shortsword skill levels

0 Unskilled 11
1 Clumsy 12
2 Familiar 13
3 Student 14
4 Practiced 15

Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist

Beholder of the Art

Prodigy
Brilliant
Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist

Beholder of the Art

Prodigy
Brilliant
Incredible
Astounding
Master

High Master
Grand Master
Warrior

High Warrior
Specialist

Beholder of the Art

Prodigy
Brilliant
Incredible
Astounding

Master

25
26
27
28
29
30

22
23
24
25
26
27
28
29
30

22
23
24
25
26
27
28
29
30

22
23
24
25
26

Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form
Student of Form
Master of Form
Initiate of Style
Student of Style
Master of Style

Initiate of Stance
Student of Stance
Master of Stance
Initiate of Form

Student of Form
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Dedicated
Skilled
Experienced
Proficient
Practitioner

Expert

Bow skill levels

© 00 N O U1 o W N H O

fun
o

Unskilled
Clumsy
Familiar
Student
Practiced
Dedicated
Skilled
Experienced
Proficient
Practitioner

Expert

Climbing skill levels
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Unskilled
Clumsy
Familiar
Student
Practiced
Dedicated
Skilled
Experienced
Proficient
Practitioner

Expert

Streetwise skill levels
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Unskilled
Simpleton
Totally Lost
Easily Confused
Easily Worried
Easily Robbed
Easily Lost

16
17
18
19
20
21

11
12
13
14
15
16
17
18
19
20
21

11

13
14
15
16
17
18
19
20
21

11
12
13
14
15
16
17

High Master 27 Master of Form
Grand Master 28 Initiate of Style
Warrior 29 Student of Style
High Warrior 30 Master of Style
Specialist

Beholder of the Art

Prodigy 22 Initiate of Stance
Brilliant 23 Student of Stance
Incredible 24 Master of Stance
Astounding 25 Initiate of Form
Master 26 Student of Form
High Master 27 Master of Form
Grand Master 28 Initiate of Style
Warrior 29 Student of Style
High Warrior 30 Master of Style
Specialist

Beholder of the Art

Prodigy 22 Initiate of Stance
Brilliant 23 Student of Stance
Incredible 24 Master of Stance
Astounding 25 Initiate of Form
Master 26 Student of Form
High Master 27 Master of Form
Grand Master 28 Initiate of Style
Warrior 29 Student of Style
High Warrior 30 Master of Style
Specialist

Beholder of the Art

Hustler

Con Artist

Street Talker

Street Hustler
Street Wise
Revealer of Thieves

Hustler of Thieves



7 Bar Hopper 18

8 Bar Talker 19
9 Smooth Talker 20
10 Fast Talker 21

Martial skill levels

0 Unskilled

1 Initiate

2 White Belt

3 Yellow Belt

4 Green Belt

5 Blue Belt

6 Red Belt

7 Brown Belt

8 Brown Belt, second degree
9 Brown Belt, third degree

10 Black Belt

Thievery skill levels

0 Unskilled 10
1 Humorous 11
2 Amusing 12
3 Drunkard 13
4 Clumsy 14
5 Pickpocket 15
6 Thief 16
7 Dexterous 17
8 Adept 18
9 Agile

Psionic skill levels
Unskilled
Beginner
Trainee
Jester
Student
Mentalist

Forger of Fire
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Defender from Ice

Master Hustler

Master Talker

Student of Glibness

Professor of

Glibness
11  Black Belt, second degree
12  Black Belt, third degree
13  Black Belt, fourth degree
14  Black Belt, fifth degree
15  Black Belt, sixth degree
16 Black Belt, seventh
degree

17  Black Belt, eighth degree
18 Black Belt, ninth degree
19 Master
20  Grand Master
21  Beholder of the Art

Swift

Expert

Shadow Seeker
Dark Striker
Shadow Thief
Master Thief
Shadow Knight

Shadow Mage
Shadow Lord

11
12
13
14
15
16
17
18

Maker of Paths
Enchanter
Controller of Ice
Worker of Force
Defier of Gravity
Master of Earth
Defier of Vision
Wizard

23
24
25
26
27

28
29

30
31

Seeker of the Sash

Bronze Sash

Bronze Sash, second degree
Bronze Sash, third degree
Bronze Sash, fourth degree

Bronze Sash, fifth degree

Bronze Sash, sixth degree

Bronze Sash, seventh
degree

Bronze Sash, eighth degree

Silver Sash



8 Forger of Ice 19 Master of

Dimensions

9 Controller of Fire 20 Master of Time
10 Concealer of Paths

Healing skill levels
0 Unskilled 9 Taker of Consciousness
1 Mender of Wounds 10 Revealer of Paths
2 Paramedic 11 Inflictor of Poison
3 Inflictor of Wounds 12 Former of Lightning
4 Student 13 Protector of the Mind
5 Curer of Poison 14 Protector of the Conscious
6 Restorer of Vision 15 Healer of the Ways
7 Healer 16 Shaker of the World
8 Healer of Wounds 17 Stealer of the Mind

Steel Flower Tavern

The Steel Flower Tavern is in northeast Nork. It boasts a fine drinking establishment, the lockers, and the
Thieves' Guild.




Thieves' Guild

The Thieves' Guild is in the Steel Flower Tavern, past the lockers, and at the end of the long hall, through the
secret door.




Armor

Armor protects you against physical attacks. You can purchase armor at the armor shops throughout the
kingdom, or you can find it as treasure. You can only wear one suit of armor at a time. There are four basic types
of armor:

ﬁ leather armor
‘%‘ studded armor

' chain armor
u plate armor

You can also have the tanner make armor from the skin, fur, feathers, or scales of some creatures.

{button ,AL("Armorinfo")} Related Topics



Cloaks
»
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Cloaks protect you against physical attacks, and some cloaks protect against psionic attacks. In addition to your
armor, you can wear two cloaks, or a cloak and a robe.




Robes protect you against physical attacks, and some robes protect against psionic attacks. In addition to your
armor, you can wear two robes, or a robe and a cloak.



Boots

b 4

Boots protect you against physical attacks, and some boots protect against psionic attacks or are psionically
imbued. You can only wear one pair of boots.



Helms

Helms protect you against physical attacks, and some helms protect you against psionic attacks or are
psionically imbued. You can wear one helm.



Bracers
ik
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Some bracers are purely ornamental, and some protect you against physical or psionic attacks. You can only
wear one set of bracers.



Gauntlets

&%

Gauntlets protect you from physical attacks and improve your ability to attack with your hands. You can only
wear one set of gauntlets.



Sashes
e =

Some sashes are purely ornamental, and some protect you against physical attacks or improve your ability to
attack in combat. You can only wear one sash.



Rings
\

Some rings are purely ornamental, some protect you against physical or psionic attacks, and some are
psionically imbued. You can only wear one ring on each hand.



Amulets

Some amulets are purely ornamental, and some protect you against psionic attacks. You can only wear one
amulet.



Gems
-]

There are a variety of gems in the kingdom. Some gems unlock doors, and some can be traded to questors for
enchanted items. All gems can be encrusted into an item or sold.



Scrolls

A\

Some scrolls provide clues about adventuring in the kingdom, and some are psionically imbued.



Bottles

=
Bottles contain a variety of fluids, including healing potions and poison potions. Bottles are rarely labeled, so be
careful what you drink. Most bottles contain one ounce of fluid, enough for one drink. You can buy bottles of
potion at the Alchemist shops, or you can find them as treasure.

{button ,AL("BottleIlnfo")} Related Topics



Shields

Shields protect you from physical attacks. For maximum blocking protection, you must hold a shield in your left
hand. If you hold it in your right hand, it blocks only as well as a weapon.



Axe

AN

To attack with an axe, you and your opponent must be standing in the same spot.



Crossbow

You can use a crossbow to attack an opponent from a distance. You must hold the bow in your right hand, and
your left hand must be empty to draw the bow.



Dagger
"%

To attack with a dagger, you and your opponent must be standing in the same spot.



Grenade
&

You can throw a grenade at an opponent or along a path.



Halberd and polearm

Halberds and polearms are long-handled weapons that you use to attack opponents who are standing near you.
To inflict maximum combat damage using a halberd or polearm, your left hand must be empty. You cannot put a
halberd or polearm on your belt.



Hammer

N

To attack with a hammer, you and your opponent must be standing in the same spot.



Longbow

7

You can use a longbow to attack an opponent from a distance. You must hold the bow in your right hand, and
your left hand must be empty to draw the bow.



Longsword

N\

To attack with a longsword, you and your opponent must be standing in the same spot.



Mace

To attack with a mace, you and your opponent must be standing in the same spot.



Shortbow

p

You can use a shortbow to attack an opponent from a distance. You must hold the bow in your right hand, and
your left hand must be empty to draw the bow.



Shortsword

%

To attack with a shortsword, you and your opponent must be standing in the same spot.



Alligator

Alligators live in water or marshy areas around the kingdom and have a nasty bite.



Bear

Bears have massive claws. Some bears are non-hostile.



Fiends are heavy-footed and vibrate the earth before they stare you down with their glowing green eyes and
shear your flesh with their claws.



Gargoyle

Gargoyles have huge wings and viciously sharp claws.



Goblin

L - |
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Goblins are the weakest creatures you will encounter. The Goblin Lord, of course, is a much more challenging
opponent.



Griffon

Griffons attack you with their powerful beaks and raking talons. The fabled silver griffon spits freezing liquid that
chills characters to the bone. If you kill a griffon, the tanner can make its feathers into strong armor.

{button ,AL("Armorinfo")} Related Topics



Hobgoblin

Hobgoblins are taller, more muscular, and more challenging opponents than goblins.



Hostile Fighter

Hostile fighters are highly skilled weapons masters.



Hostile Psionicist

Hostile psionicists are highly skilled Mentalists.




Lizardman

%

Lizardmen are known for their hissing, muffled speech and fire breath. The Lizard King, of course, is a much more
challenging opponent.



Lurker

Lurkers drool, drag their knuckles on the ground, and bite you.



Mummy
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Mummies shuffle along, waiting to attack you.



Ogre

Ogres are brutes of great strength who dress like samurai warriors.



Orcs are squat, with piggish snouts, and are fond of rallying battle cries, such as "Crush the human!"



Rakshasa

%
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Rakshasas are well-muscled, with tiger-like faces and wild hair. They are often preceded by a hint of pipe smoke.



Rockman

Rockmen make loud grinding noises and pound their opponents with their massive fists.



Sanquin

Sanquins are covered with icy blue scales and attack with sharp claws and an icy breath of pounding hail and
bitter cold.



Shark
4

Sharks swim in any body of water and have a nasty bite.



Thumpers club you with their fists.



Troglodyte
|

Troglodytes attack with weapons.



Troll

Trolls are strong and tend to attack with large weapons.



Wolves tend to hunt in packs and have a fierce bite. Some wolves are non-hostile.



Yetis are snow beasts who swipe at their opponents with their sharp claws. Yetis have thick fur and are hard to
kill. The fur of a dead yeti makes strong armor.

{button ,AL("Armorinfo")} Related Topics



Body, Disciplines, Ground button

Click this button to display what you are wearing. Click it a second time to display the psionic disciplines you are
under the influence of. Click it a third time to open or close the Ground window.



Drop Succor Twig button

Click this button to drop a succor twig that you are holding in your hand, carrying on your belt, carrying in your
pouch, or carrying in your sack.

If you are holding a succor twig in one of your hands, that is the twig you drop. If you are not holding a succor
twig in your hands, you drop the first succor twig on your belt (from left to right). If you are not carrying a succor
twig on your belt, you drop the first succor twig in your pouch (from left to right). If you are not carrying a succor
twig in your pouch, you drop the first succor twig in your sack (from left to right).



Drink Healing Potion button

Click this button to drink a healing potion that you are holding in your hand, carrying in your sack, or carrying in
your pouch.

If you are holding a healing potion in one of your hands, that is the potion you drink. If you are not holding any
healing potions in your hands, you drink the first healing potion in your sack (from left to right). If you are not
carrying any healing potions in your sack, you drink the first healing potion in your pouch (from left to right).



Show Ground button

Click this button to look at the ground where you are standing.



Initiate Attack button

Click this button to make the command shown on the Attack Commands pop-up menu appear on the command
line.



Form Discipline button

Click this button to make the discipline shown on the Disciplines pop-up menu appear on the command line.



Initiate Attack button

Click this button to make the command shown on the Attack Commands pop-up menu appear on the command
line.



Initiate Action button

Click this button to make the command shown on the Action Commands pop-up menu appear on the command
line.



Send Command Line button

Click this button to send the contents of the command line. You can also do this by pressing ENTER.



And button

Click this button to enter the word "and" on the command line between multiple commands.



Clear Command Line button

Click this button to clear the contents of the command line. You can also do this by pressing ESC.



Identity box

An Identity box appears for each creature and character near you. It shows the character or creature's name,
flag, contents of right and left hands, armor, and health display.



Repeat Command button

Click this button to repeat the previous command.



Sack button

Click this button to display the contents of your sack.



Pouch button

Click this button to display the contents of your pouch.



Belt button

Click this button to display the contents of your belt.



Narrative window

Displays information about your actions, location, combat, and conversations.



Attack Commands pop-up menu

Click this button to display a list of combat commands.



Attack Commands pop-up menu

Click this button to display a list of combat commands.



Disciplines pop-up menu

Click this button to display a list of the psionic disciplines you can form.



Action Commands pop-up menu

Click this button to display a list of action commands.



Health display

Click this button to display your health points as numbers or as a bar gauge.



Energy display

Click this button to display your energy points as numbers or as a bar gauge.



Experience display

Click this button to display your experience points or your experience level.



Face

Displays your expression, which is usually normal. But it can change if you are injured in some way, for example,
if you are stunned, poisoned, or dead



Left Hand

Displays what you are holding in your left hand.



Right Hand

Displays what you are holding in your right hand.



Encumbrance display
Indicates how much weight you are carrying. If you are encumbered, even lightly, you move slower.

it

S No weights appear on the scale if you are unencumbered.

ii i

i One weight appears on the scale if you are lightly encumbered.
ii i
i Two weights appear on the scale if you are moderately encumbered.
iiff
i

Three weights appear on the scale if you are heavily encumbered.



Command line

Type commands and messages on the command line.



Round timer

When the round timer is green, you can enter commands. When the round timer is red, your last command is still
being processed.



Terrain window

Displays your surroundings.



Fighter trainer

The Fighter trainer provides weapons skill training to members of any profession; however, Fighters receive
preferential pricing.



Mentalist trainer

The Mentalist trainer provides psionics skill training to members of any profession; however, Mentalists receive
preferential pricing.



Martial Arts trainer

The Martial trainer provides martial arts skill training to members of any profession; however, Martial Artists
receive preferential pricing.



Healer trainer

The Healer trainer provides healing skill training to members of any profession; however, Healers receive
preferential pricing.



Thief trainer

The Thief trainer provides thievery skill training to members of any profession; however, Thieves receive
preferential pricing.



Paladin trainer

The Paladin trainer provides weapons skill training to members of any profession; however, Paladins receive
preferential pricing.



Barbarian trainer

The Barbarian trainer provides weapons skill training to members of any profession; however, Barbarians receive
preferential pricing.



Assess Skill button

Assessing a skill shows your percentage of advancement toward the next skill level.

To have the trainer assess your skill, click the skill you want to assess, and then click this button.



Skill Train button

Skill training helps you advance to higher skill levels more quickly than you could by slaying opponents.

To receive skill training, click the skill you want to train in, and then click this button.



Dedicate button

Click this button to dedicate your life to the pursuit of the profession the trainer represents. You can only
dedicate to one profession, so consider which profession best suits your abilities before you dedicate.



Class Train button

Click this button to receive the psionic disciplines or increased number of attacks that you may have earned by
advancing to a higher skill level. You should always class train after you advance to a higher skill level.



Female icon

Click here to create a female character.



Male icon

Click here to create a male character.



Items for sale and prices

Displays the items a shopkeeper sells. Prices are shown beneath each item.



Coins in sack

Displays the number of coins in your sack.



Sack icon

Drag an item here to put it in your sack.



Belt icon

Drag an item here to put it on your belt.



Pouch icon

Drag an item here to put it in your pouch.



Account Balance

Displays the balance of your bank account.



Deposit button

Click this button to deposit coins into your bank account.



Withdraw button

Click this button to withdraw coins from your bank account.



Name

Displays your character's name.



Race

Displays your character's race.






